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Paper Set 1 · 02 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A cuboidal tank of size 72 cm × 54 cm × 24 cm is half-filled with
water. A solid cube is dropped into the tank so that the water rises to
the brim. Find the edge of the cube.

A.  27 cm

B.  29 cm

C.  32 cm

D.  36 cm

✓

Q2 Quant
A vendor bought 16 toffees for 20 rupees. How many toffees should
he sell for 3 rupees for a 20% gain?

A.  1

B.  2

C.  3

D.  6

✓

Q3 Quant
What number should be subtracted from each of the numbers 30,
39, 7.5 and 9 so that the resultant numbers are in proportion?

A.  1

B.  2

C.  3

D.  4

✓

Q4 Quant
Which of the following numbers is the least common multiple of 12,
15, 18, and 20?

A.  60

B.  90

C.  120

D.  180

✓

Q5 Quant
A student's final grade in a math class is based on the following
components and weights:
Assignments: 20%
Quizzes: 30%
Mid-term Exam: 25%
Final Exam: 25%.
The student's scores were (out of 100):
Assignments: 90%
Quizzes: 85%
Mid-term Exam: 78%
Final Exam: 82%.
What is the student's final weighted average grade?

A.  83.5%

B.  81.5%

C.  76.5%

D.  79.5%

✓

Q6 Quant
If a person earns ₹2500 and spends ₹1300, what is his savings as a
percentage of his income?

A.  42%

B.  48%

C.  52%

D.  56%

✓

Q7 Quant
Twice a number exceeds its two‑thirds by 72. Find the number.

A.  48

B.  54

C.  96

D.  24

✓

Q8 Quant
A person covers three equal distances at the speeds of 15 km/hr, 20
km/hr and 25 km/hr, respectively. Find the average speed of the
whole journey. (Rounded off to two decimal places)

A.  17.65 km/hr

B.  20.48 km/hr

C.  22.51 km/hr

D.  19.15 km/hr
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✓

Q9 Quant
If the weights corresponding to all observations in a dataset are
multiplied by 3, how does the weighted mean of the dataset
change?

A.  It becomes three times the original weighted mean

B.  It remains unchanged

C.  It becomes one-third of the original weighted mean

D.  It becomes nine times the original weighted mean

✓

Q10 Quant
Two numbers are in the ratio 12:19. If 24 is added to each, the ratio
becomes 16:23. The positive difference between the numbers is:

A.  24

B.  32

C.  42

D.  56

✓

Q11 Quant
If 20% of a number is added to 36, then the result is the same
number. 60% of the same number is:317

A.  27

B.  18

C.  57

D.  47

✓

Q12 Quant
A shopkeeper fixes the marked price of an item at 50% above its
cost price. What percentage of discount on the marked price should
be allowed to gain 8%?

A.  28%

B.  27%

C.  30%

D.  29%

✓

Q13 Quant
Kartik has ₹1281 with him. He divided it amongst his sons Ishan and
Krish and asked them to invest it at 10% rate of interest
compounded annually. It was seen that Ishan and Krish got same
amount after 19 and 20 years, respectively. How much money (in ₹)
did Kartik give to Krish?10089

A.  610

B.  671

C.  460

D.  771

✓

Q14 Quant
The total surface area of a solid cylinder having radius 9 cm and
height 18 cm is:2691

A.  486π cm2

B.  396π cm2

C.  564π cm2

D.  424π cm2

✓

Q15 Quant
Nitin and Pravin together can paint a hall in 3 days. Nitin alone can
paint it in 6 days. In how many days can Pravin alone paint 16 such
halls?

A.  96

B.  95

C.  97

D.  94

✓

Q16 Quant
Ankita travelled a certain distance at some speed. Had she moved 6
km/hr faster, she would have taken 80 minutes less. If she had
moved 4 km/hr slower, she would have taken 80 minutes more.
What is the distance (in km)?

A.  40

B.  80

C.  160

D.  200
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✓

Q17 Quant

A.  ₹3,500

B.  ₹3,550

C.  ₹3,600

D.  ₹3,650

✓

Q18 Quant
A can complete a piece of work in 8 days, B can complete the same work in 11 days. If both start work together, how much work is done in 4
days?

A.  

B.  

C.  

D.  

✓

Q19 Quant
The ratio of the lengths of two corresponding sides of two similar triangles is 8 : 1. The ratio of the areas of these two triangles, in the order
mentioned, is:1098

A.  64 : 1

B.  8 : 1

C.  

D.  1 : 64

✓

Q20 Quant

A.  28

B.  31

C.  25

D.  29
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GA

✓

Q21 GA
Who among the following became India’s 87th Grandmaster in July
2025?

A.  Harikrishnan A. Ra.

B.  R. Praggnanandhaa

C.  Arjun Erigaisi

D.  Vidit Gujrathi

✓

Q22 GA
Which of the following districts in Odisha does NOT have significant
manganese deposits?

A.  Keonjhar

B.  Rayagada

C.  Balangir

D.  Jajpur

✓

Q23 GA
Which of the following convex lenses has the maximum focal
length?

A.  Power +2 D

B.  Power +5 D

C.  Power +10 D

D.  Power +20 D

✓

Q24 GA
What would be the most likely effect on the plant, if the phloem
tissue in a plant stem gets damaged?

A.  Leaves will wilt due to reduced water supply

B.  Food will accumulate in the leaves, and roots will stop
growing properly

C.  The plant will immediately dry up due to a lack of minerals

D.  The rate of photosynthesis will increase

✓

Q25 GA
Which initiative did the Odisha government launch in 2025 to
empower women in the transport sector, offering interest-free loans
up to ₹10 lakh for four-wheel taxis?

A.  Ama Sakhi Taxi Yojana

B.  Ama Su Vahak Programme

C.  Mahila Taxi Udyam Scheme

D.  Women Wheels Odisha Initiative

✓

Q26 GA
The Odia film Pushkara, starring Sabyasachi Mishra, won the Best
Odia Feature Film at the National Film Awards 2025. Which year’s
films did this award cover?

A.  2022

B.  2023

C.  2024

D.  2025

✓

Q27 GA
The Maria Corina Machado was awarded the 2025 Nobel Peace Prize
for her long-standing work in which country?

A.  Colombia

B.  Venezuela

C.  Brazil

D.  Argentina

✓

Q28 GA
In which year was the establishment of the international Coalition
for Disaster Resilient Infrastructure (CDRI) formally approved?

A.  2014

B.  2016

C.  2019

D.  2020

✓

Q29 GA
In September 2025, India inaugurated its first overseas defence
manufacturing facility under the Atmanirbhar Bharat initiative in
which country?

A.  Algeria

B.  Tunisia

C.  Morocco

D.  South Africa

✓

Q30 GA
In August 2025, in which state PM Narendra Modi has inaugurated
the Urban Extension Road-II (UER-II)?

A.  Delhi

B.  Odisha

C.  Andhra Praddesh

D.  Jharkhand
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✓

Q31 GA
Which landform is formed as a result of glacial deposition?

A.  Delta

B.  Moraine

C.  Canyon

D.  Plateau

✓

Q32 GA
Which of the following correctly identifies the first synchronous
Census of India?

A.  1901

B.  1881

C.  1865

D.  1872

✓

Q33 GA
Which of the following is an INCORRECT statement regarding the
reaction between metallic oxides and acids?

A.  Metallic oxides act as bases during reaction with acids

B.  Metallic oxides react with acids to produce carbon dioxide

C.  Metallic oxides combine with acids in a neutralisation
reaction

D.  Metallic oxides neutralise acids to produce salt and water

✓

Q34 GA
Which of the following best explains the cultural significance of the
classical dance form Odissi in modern Odisha?

A.  It originated as a royal court dance during the Mughal period

B.  It was revived after independence and is closely linked to
temple traditions of Lord Jagannath

C.  It developed mainly as a tribal war dance in northern Odisha

D.  It is a modern dance form created in the 20th century with
no historical roots

✓

Q35 GA
If a cultural program wanted to showcase the unique sound of the
santoor, which artist from the 20th century would be the most
appropriate to invite based on historical association?

A.  Ustad Asad Ali Khan

B.  Pandit Shiv Kumar Sharma

C.  Zakir Hussain

D.  Ustad Amjad Ali Khan

✓

Q36 GA
Who among the following is the author of 'The Guide'?

A.  Mulk Raj Anand

B.  R. K. Narayan

C.  Raja Rao

D.  Khushwant Singh

✓

Q37 GA
Which of the following landforms is most commonly found in the
Thar Desert?

A.  Moraines

B.  Sand dunes

C.  V-shaped valleys

D.  Lava plateaus

✓

Q38 GA
Which of the following is NOT a Fundamental Right mentioned in
Indian Constitution at present?

A.  Right to equality

B.  Right to property

C.  Right against exploitation

D.  Right to freedom of religion

✓

Q39 GA
Who was the leader of the Munda Rebellion (1899-1900) against
British rule?

A.  Sidhu Murmu

B.  Birsa Munda

C.  Tilka Manjhi

D.  Tana Bhagat

✓

Q40 GA
India’s Human Development Index (HDI) rank in the 2025 Human
Development Report released in May 2025 is:

A.  One hundred thirty

B.  One hundred twenty

C.  One hundred fifty

D.  One hundred ten
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English

✓

Q41 English
Complete the sentence by filling in the blank with the correct option.

Ajay practiced ____ to win the badminton championship and surprised everyone by defeating the reigning champion.

A.  hardly

B.  hard

C.  hardest

D.  harder

✓

Q42 English
Select the most appropriate proverb that can substitute the highlighted segment in the given sentence.

The minister was arrested for fraud, which proves that your actions determine your future outcomes.

A.  where there is smoke, there is fire

B.  necessity is the mother of invention

C.  you reap what you sow

D.  crime does not pay

✓

Q43 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The speaker stepped onto the stage and addressed the solemn assembly of hearers that had gathered to hear this testimony.

A.  brigand

B.  deponent

C.  assemblage

D.  gynecologist

✓

Q44 English
Select the option that can be used as a one-word substitute for the highlighted segment in the given sentence.

Because it was considered an entry made without permission of privacy, the hotel owner was arrested for installing cameras in the rooms.

A.  entrant

B.  intrusion

C.  expulsion

D.  attainment
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✓

Q45 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(P) while many butterfly species showed population declines
(Q) skipper, cryptic wood white and chalk hill blue seeing
(R) sharp drops compared to the previous year
(S) last year, nine suffered their worst year on record - with the grizzled

A.  PSQR

B.  PSRQ

C.  PRQS

D.  QSPR

✓

Q46 English
Read the sentence carefully and choose the correct future tense verb form to complete it meaningfully.

By this time next month, the team ________ data from the newly discovered cave system.

A.  has collected

B.  will collects

C.  will collected

D.  will have collected

✓

Q47 English
In the following question, a statement has been given in brackets. You are required to replace the statement with the correct idiom given in the
options.
During the meeting, Arjun refused to admit his mistake. He (ignored the problem intentionally) and avoided responsibility.

A.  Drew the line

B.  Spoke his mind

C.  Turned a blind eye

D.  Lost track of time

✓

Q48 English

Read the passage and answer the questions that follow.

Trees are vital to life on Earth. They produce oxygen, absorb carbon dioxide, and prevent soil erosion. Forests provide habitats for countless
species of animals and plants, maintaining ecological balance. Trees also offer fruits, timber, and shade. In cities, they reduce pollution, lower
temperatures, and improve mental health. However, deforestation has become a major problem due to urbanization, logging, and agriculture.
Large-scale tree cutting causes loss of biodiversity, climate changes, and natural disasters like floods. Protecting existing forests and planting
new trees are essential to ensure a sustainable environment. Every individual’s effort to plant and care for trees contributes to a healthier planet
for future generations.

According to the passage, what do trees absorb from the atmosphere?

A.  Oxygen

B.  Nitrogen

C.  Carbon dioxide

D.  Methane
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✓

Q49 English
What is the main theme of the passage?

A.  The economic value of timber and fruits

B.  The importance of trees and the need to prevent deforestation

C.  The process of photosynthesis in plants

D.  The cultural uses of trees in different countries

✓

Q50 English
Which of the following titles best suits the passage?

A.  The Economic Value of Forests

B.  The Wonders of Photosynthesis

C.  Trees: Nature’s Protectors

D.  Life in the Urban Jungle

✓

Q51 English
Which statement best describes the structure of the passage?

A.  It describes the benefits of trees, discusses problems caused by deforestation, and ends with a solution for sustainability.

B.  It compares trees with other plants and describes their anatomy.

C.  It narrates a story about planting trees in a city.

D.  It lists random facts about forests without conclusion.

✓

Q52 English
Choose the antonym of the word “sustainable” as used in the passage.

A.  Balanced

B.  Durable

C.  Temporary

D.  Continuous

✓

Q53 English
Select the most appropriate antonym of the underlined word in the given sentence.

The abundant rainfall led to a good harvest that year.

A.  Plentiful

B.  Scarce

C.  Efficient

D.  Medium
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✓

Q54 English
Choose the correct option to complete the indirect speech sentence.

The guide explained that the sculpture ______ during the late medieval period.

A.  was created

B.  is created

C.  has been created

D.  will be created

✓

Q55 English
Arrange the following to create a logical, grammatically correct sentence.

(1) after he had studied
(2) for the exam
(3) John felt confident
(4) for several weeks

A.  After he had studied John felt confident for several weeks for the exam.

B.  John felt confident for the exam after he had studied for several weeks.

C.  For several weeks after he had studied John felt confident for the exam.

D.  For the exam John felt confident after he had studied for several weeks.

✓

Q56 English
Identify the antonym of intricate in the following sentence.
The marooned survivors improvised a rudimentary shelter from flotsam to mitigate the effects of the torrential rain.

A.  marooned

B.  improvised

C.  rudimentary

D.  torrential

✓

Q57 English
Select the INCORRECTLY spelt word.
They were to be dragged through the publicity, the humeliations, that precede the sundering of what God has joined together.

A.  dragged

B.  publicity

C.  humeliations

D.  precede

✓

Q58 English
Select the most suitable option to complete the sentence.
She answered all the questions ________, showing a deep understanding of the subject matter.

A.  forcibly

B.  thoroughly

C.  roughly

D.  timidly
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✓

Q59 English
Select the most appropriate option to fill in the blanks.
She liked ____ dress displayed in ____ shop of the designer boutique she had visited earlier.

A.  a; a

B.  a; an

C.  an; a

D.  the; the

✓

Q60 English
Select the option that expresses the given sentence in passive voice.

Ananya completed the homework.

A.  The homework is completed by Ananya.

B.  The homework was completed by Ananya.

C.  The homework has been completed by Ananya.

D.  The homework will be completed by Ananya.

Odia

✓

Q61 Odia
ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ସମ୍ବାଦପତ୍ର  ହେଉଛି  ଗଣତନ୍ତ୍ରର ____ ସ୍ତମ୍ଭ ।''

A.  ପଞ୍ଚମ

B.  ଷଷ୍ଠ

C.  ସପ୍ତମ

D.  ଚତୁ ର୍ଥ

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ଫୁ ଲଗୁ ଡ଼ି କ ବହୁ ତ "ସୁ ନ୍ଦର" ଅଟନ୍ତି ।

A.  ଖରାପ

B.  ଦୀର୍ଘ

C.  ଗରି ବ

D.  ନୂ ତନ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଇସ୍ରୋ  ଭାରତର ମହାକାଶୀୟ ଅନୁ ସନ୍ଧାନ ସଂସ୍ଥା ଅଟେ ।

A.  ISRO is India’s space research organization.

B.  ISRO is an American company.

C.  ISRO controls Indian railways.

D.  ISRO is a weather forecasting agency.

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଚନ୍ଦ୍ରଗୁ ପ୍ତ ମୌର୍ଯ୍ୟ  ମୌର୍ଯ୍ୟ  ସାମ୍ରା ଜ୍ୟର ପ୍ର ତି ଷ୍ଠାତା ଥି ଲେ ।

A.  Chandragupta Maurya was the founder of the Mauryan Empire.

B.  Chandragupta Maurya were founder for Mauryan empire.

C.  The Chandragupta is founding Mauryan Empire.

D.  Chandragupta Maurya be the found of Empire.

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Deforestation leads to soil erosion and loss of wildlife habitat.

A.  ନି ର୍ବ ନୀକରଣ କାରଣରୁ  ମୃ ତ୍ତି କା କ୍ଷୟ ଏବଂ ବନ୍ୟଜୀବନସ୍ଥଳୀ କ୍ଷୟ ହୋଇଯାଏ।

B.  ବନକାଟ ମାଟି  ଭାସି  ଏବଂ ପ୍ରା ଣୀ ଆବାସ ହାନି  ଘଟି ଲା।

C.  ବନକାଟ ମାଟି କୁ  ଭାସାଇ ଏବଂ ପ୍ରା ଣୀ ଆବାସ ହାନି  ହେଲା।

D.  ବନକାଟ ମାଟି  ଭାସାଇ ଏବଂ ପ୍ରା ଣୀ ଆବାସ ହାନି  ହୁ ଏ।

✓

Q66 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଆନନ୍ଦ

A.  ପ୍ର ଫୁ ଲ୍ଲ

B.  ବି ଷାଦ

C.  ନୃ ତ୍ୟ

D.  ସଙ୍ଗୀତ
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✓

Q67 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

ଭାରତୀୟ ସି ନେମାର ସବୁ ଠାରୁ  ପ୍ରି  ୟ ହାସ୍ୟ ଅଭି ନେତା ଗୋବର୍ଦ୍ଧ ନ ଆସରାନି , ଆସରାନି  ନାମରେ ବେଶ ଲୋକପ୍ରି  ୟ ଅର୍ଜ ନ କରି ଥି ଲେ । ସେ ଜାନୁ ଆରୀ 1, 1941 ରେ ରାଜସ୍ଥାନର ଜୟପୁ ରରେ
ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ | ଦୀର୍ଘ  ଦଶନ୍ଧି  ଧରି  ହାସ୍ୟ ଭୂ ମି କା କୁ  ନି ଖୁ ଣ ଭାବେ ନି ଭାଇ ଦର୍ଶ କଙ୍କୁ  ହସାଇବାର ତାଙ୍କର ଅନନ୍ୟ କ୍ଷମତା ମାଧ୍ୟମରେ ସେ ଘରେ ଘରେ ପରି ଚି ତ ହୋଇଥି ଲେ।

ଚଳଚ୍ଚି ତ୍ର  ଜଗତରେ ପାଦ ଦେବା ଲାଗି  ସେ ପୁ ଣେର ଫି ଲ୍ମ ଆଣ୍ଡ ଟେଲି ଭି ଜନ ଇନଷ୍ଟି ଚ୍ୟୁ ଟ୍  ଅଫ୍  ଇଣ୍ଡି ଆ (FTII) ରେ ଅଭି ନୟରେ ତାଲି ମ ନେଇଥି ଲେ। ତାଙ୍କର ପ୍ର ଥମ ପ୍ର ଦର୍ଶ ନ 1960 ଦଶକର ଶେଷ
ଭାଗରେ ହୋଇଥି ଲା, କି ନ୍ତୁ 1970 ଦଶକରେ ସେ ଷ୍ଟାରଡମ ହାସଲ କରି ଥି ଲେ । ହୃ ଷୀକେଶ ମୁ ଖାର୍ଜୀ  ଏବଂ ରାଜ କପୁ ରଙ୍କ ପରି  ପ୍ର ସି ଦ୍ଧ ନି ର୍ଦ୍ଦେ ଶକଙ୍କ ସହ କାମ କରି ବାରୁ  ତାଙ୍କୁ  ଅନେକ ପ୍ର କାରର
ହାସ୍ୟରସ ଅଭି ନୟର ପ୍ର ଦର୍ଶ ନ କରି ବାରେ ସାହାଯ୍ୟ ମି ଳି ଥି ଲା ।

1975 ମସି ହାର ବ୍ଲ କବଷ୍ଟର ଫି ଲ୍ମ "ଶୋଲେ"ରେ ଆସରାନି ଙ୍କ ସବୁ ଠାରୁ  ପ୍ର ସି ଦ୍ଧ ଭୂ ମି କା ଥି ଲା, ଯେଉଁ ଠାରେ ସେ ବ୍ରି  ଟି ଶ ଅଧି କାରୀମାନଙ୍କୁ  ବ୍ୟଙ୍ଗ କରି  ଏକ ଅଦ୍ଭୁ ତ ଜେଲର ଭୂ ମି କାରେ ଅଭି ନୟ
କରି ଥି ଲେ। ତାଙ୍କର ପ୍ର ସି ଦ୍ଧ ପଂକ୍ତି  - "ହମ୍  ଅଙ୍ଗରେଜୋଁ  କେ ଜମାନେ କେ ଜେଲର୍  ହେ!" - ଲୋକପ୍ରି  ୟ ସଂସ୍କୃତି ରେ ସ୍ଥାନି ତ ହୋଇ ରହି ଛି  । ଏହି  ଭୂ ମି କା ତାଙ୍କର ବ୍ୟଙ୍ଗ ପ୍ର ତି ଭାକୁ  ପ୍ର ଦର୍ଶ ନ କରି ଥି ଲା,
ଏବଂ ଆଜି  ମଧ୍ୟ ଦର୍ଶ କମାନେ ସେହି  ସଂକ୍ଷି ପ୍ତ କି ନ୍ତୁ ଅବି ସ୍ମରଣୀୟ ଅଭି ନୟକୁ  ଭାରତୀୟ ସି ନେମାର ସବୁ ଠାରୁ  ମଜାଦାର ମୁ ହୂ ର୍ତ୍ତ  ଭାବରେ ମନେ ରଖନ୍ତି । ଆସରାନି  350 ରୁ  ଅଧି କ ଫି ଲ୍ମରେ ଅଭି ନୟ
କରି ଥି ଲେ, । ସେ ରାଜେଶ ଖାନ୍ନା, ଅମି ତାଭ ବଚ୍ଚନ ଏବଂ ସଲମାନ ଖାନଙ୍କ ପରି  ତାରକାଙ୍କ ସହି ତ ଅଭି ନୟ କରି ଥି ଲେ, ଓ ତାଙ୍କ ବହୁ ମୁ ଖୀ ପ୍ର ତି ଭା ପାଇଁ  ସେ ପ୍ର ଶଂସା ଅର୍ଜ ନ କରି ଥି ଲେ। କମେଡି
ବ୍ୟତୀତ, ଆସରାନି  ଗମ୍ଭୀର ଭୂ ମି କାରେ ମଧ୍ୟ ନି ଜର ଦକ୍ଷତା ପ୍ର ମାଣି ତ କରି ଥି ଲେ ଏବଂ ନି ର୍ଦ୍ଦେ ଶନା କ୍ଷେତ୍ର ରେ ମଧ୍ୟ କାର୍ଯ୍ୟ  କରି ଥି ଲେ।

ଆହୁ ରି  ମଧ୍ୟ ଆସରାନି  ଟେଲି ଭି ଜନ ଧାରାବାହି କ ଏବଂ ଆଧୁ ନି କ ହି ନ୍ଦୀ ଚଳଚ୍ଚି ତ୍ର  ଗୁ ଡ଼ି କରେ ଦର୍ଶ କଙ୍କୁ  ଆକର୍ଷିତ କରି ଥି ଲେ,। ଭାରତୀୟ ସି ନେମାରେ ତାଙ୍କର ଅବଦାନ ହସଠାରୁ  ଅଧି କ - ସେ ଚରି ତ୍ର
ଅଭି ନେତା ମାନଙ୍କ ପାଇଁ  ଏକ ମାନଦଣ୍ଡ ସ୍ଥାପନ କରି ଥି ଲେ ଏବଂ ଆଗାମୀ ପି ଢ଼ି ର ହାସ୍ୟ ଅଭି ନେତାଙ୍କୁ  ପ୍ରେ ରଣା ଦେଇଥି ଲେ। ଆସରାନି ଙ୍କ ହାସ୍ୟରସ କୁ  ଭାବନା ସହି ତ ମି ଶ୍ର ଣ କରି ବାର ତାଙ୍କର ଦକ୍ଷତା
ତାଙ୍କୁ  ଅନ୍ୟ ହାସ୍ୟ ଅଭି ନେତା ଙ୍କ ଠୁ  ସ୍ଵତନ୍ତ୍ର କରି ଥାଏ । 84 ବର୍ଷ  ବୟସରେ 20 ଅକ୍ଟୋବର 2025 ରେ ସେ ପରଲୋକ ଗମନ କରି ଛନ୍ତି  |

ଅସରାନୀ କେଉଁ ଠାରେ ଜନ୍ମ  ଗ୍ର ହଣ କରି ଥି ଲେ?

A.  ମୁ ମ୍ବାଇ

B.  ଜୟପୁ ର

C.  ଦି ଲ୍ଲୀ

D.  ପୁ ଣେ

✓

Q68 Odia
କେଉଁ  ଚଳଚ୍ଚି ତ୍ର ରେ ଆସରାନୀ ଜଣେ ବ୍ୟଙ୍ଗାତ୍ମକ ଜେଲର ଭୂ ମି କାରେ ଅଭି ନୟ କରି ଥି ଲେ?

A.  ଚୁ ପକେ ଚୁ ପକେ

B.  ଗୋଲମାଲ୍

C.  ଶୋଲେ

D.  ଅମର ଆକବର ଆନ୍ଥୋନି

✓

Q69 Odia
କେବେ ଆସରାନୀଙ୍କ ପରଲୋକ ଘଟି ଥି ଲା ?

A.  25 ଅକ୍ଟୋବର 2025

B.  20 ଅକ୍ଟୋବର 2025

C.  27 ଅକ୍ଟୋବର 2025

D.  22 ଅକ୍ଟୋବର 2025

✓

Q70 Odia
ଆସରାନୀ ପ୍ରା ୟ କେତେ ଚଳଚ୍ଚି ତ୍ର ରେ ଅଭି ନୟ କରି ଛନ୍ତି ?

A.  100

B.  200

C.  350

D.  500
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✓

Q71 Odia
ଅନ୍ୟ ହାସ୍ୟ ଅଭି ନେତାଙ୍କ ମଧ୍ୟରେ ଆସରାନୀଙ୍କୁ  କେଉଁ  ଗୁ ଣ ସ୍ୱତନ୍ତ୍ର କରି ଥି ଲା?

A.  ତାଙ୍କର ଗମ୍ଭୀର ସ୍ୱର

B.  ହାସ୍ୟରସକୁ  ଭାବନା ସହି ତ ମି ଶ୍ର ଣ କରି ବାର ତାଙ୍କର କ୍ଷମତା

C.  ତାଙ୍କର ନୃ ତ୍ୟ ଦକ୍ଷତା

D.  ତାଙ୍କର ଖଳନାୟକ ଭୂ ମି କା

✓

Q72 Odia
"ଖାଇବା" କେଉଁ  ପ୍ର କାରର ପଦ?

A.  କ୍ରି  ୟାବାଚକ ବି ଶେଷ୍ୟ

B.  ସମାପି କା କ୍ରି  ୟା

C.  ବି ଶେଷଣ

D.  ଅସମାପି କା କ୍ରି  ୟା

✓

Q73 Odia
‘ଦଫାରଫା କରି ବା’ ରୂ ଢି ର ଅର୍ଥ  ଚି ହ୍ନଟ କର ।

A.  ମକଦମା ଫଇସଲା କରି ବା

B.  ଜୀବି କା ବୁ ଡ଼ାଇବା

C.  ଦୋଷ ମାନି ବା

D.  ସମସ୍ତ ଖ୍ୟାତି  ହରାଇବା

✓

Q74 Odia
ବି ଲେଇଟି  କ୍ଷୀର ------------- । ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର ।

A.  ଗୀତ

B.  ମାଛ

C.  ପି ଉଛି

D.  ଆସି ଛି

✓

Q75 Odia
ଠି କ୍  ଶବ୍ଦଟି  ଚି ହ୍ନାଇ ଦି ଅ?

A.  ମନ୍ତ୍ରୀମନଲ

B.  ମନ୍ତ୍ରି ମଣ୍ଡଳ

C.  ମନ୍ତ୍ରୀ ମଣ୍ଡଳ

D.  ମନ୍ତ୍ରୀର୍ମ ଣ୍ଡଳ
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Computer

✓

Q76 Computer
Which of the following defines template in MS PowerPoint 2021?

A.  A blank slide

B.  A pre-designed layout

C.  A sound effect

D.  A video transition

✓

Q77 Computer
Where in MS-PowerPoint is the "Save" option?

A.  On the Home tab

B.  On the File tab (Backstage view)

C.  On the Insert tab

D.  On the View tab

✓

Q78 Computer
In PowerPoint you want to change the default file format in which
presentations are saved (e.g., to .odp or other). Which setting allows
this?

A.  File → Export → Create Video

B.  File → Options → Save → “Save files in this format”

C.  Insert → Media → Video

D.  Review → Protect → Format

✓

Q79 Computer

In context of sorting data in MS Excel 2021, match commands in
Column A with their descriptions in Column B :

Column A – Sorting
Command

Column B – Description

1. Sort A → Z
a) Sorts text values in descending
alphabetical order.

2. Sort Z → A
b) Sorts text values in ascending
alphabetical order.

3. Sort Smallest to
Largest

c) Sorts numeric data from the lowest
value to the highest

4. Sort Largest to
Smallest

d) Sorts numeric data from the highest
value to the lowest

A.  1–a, 2–b, 3–d, 4–c

B.  1–b, 2–a, 3–c, 4–d

C.  1–a, 2–b, 3–c, 4–d

D.  1–c, 2–d, 3–a, 4–b

✓

Q80 Computer
Cache memory is located between which two components?

A.  CPU and Hard Disk

B.  RAM and ROM

C.  CPU and RAM

D.  Keyboard and CPU

✓

Q81 Computer
Which of the following is an example of an output device?

A.  Keyboard

B.  Scanner

C.  Monitor

D.  Barcode reader

✓

Q82 Computer
Robotics, automated assembly lines, and computer-controlled
machines are examples of computer applications in:

A.  Medical Diagnosis

B.  Manufacturing Industry

C.  Schools and Colleges

D.  Weather Forecasting

✓

Q83 Computer
When you select text and press Ctrl+Shift+V in MS Word, which
action is performed?

A.  Paste the copied content from the clipboard

B.  Paste the copied content and match the formatting of the
destination

C.  Paste the copied content and preserve its original formatting

D.  Paste only plain text from the clipboard

✓

Q84 Computer
What is the purpose of the Inbox in an email account?

A.  To store emails that have been sent.

B.  To store emails that are waiting to be sent.

C.  To store received emails from others.

D.  To store deleted emails.
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✓

Q85 Computer
If you sort one column in a big dataset without choosing every
column, what would happen?

A.  Excel will ask for a password

B.  Only that column changes, and data gets mismatched

C.  The difference between A1 and A5

D.  The product of A1 to A5

✓

Q86 Computer
Which device is primarily used to output data as hard copy
documents?

A.  Mouse

B.  Printer

C.  Scanner

D.  Speaker

✓

Q87 Computer
Which tool is commonly used for virtual meetings and screen
sharing?

A.  Instagram

B.  WhatsApp

C.  Blogger

D.  Zoom

✓

Q88 Computer
A financial analyst copies a column of calculated tax values and
needs to paste only the final numeric results into a summary sheet
to prevent accidental formula tampering. Which Excel shortcut
should they use to paste only the values?

A.  Alt + V + S + V

B.  Alt + S + E + V

C.  Alt + E + S + V

D.  Alt + E + S + R

✓

Q89 Computer
What keyboard shortcut is used to justify align text in a paragraph in
MS Word?

A.  Ctrl + J

B.  Ctrl + L

C.  Ctrl + E

D.  Ctrl + R

✓

Q90 Computer
Identify the extension used for MS-Word Template File.

A.  .dotx

B.  .dotm

C.  .doc

D.  .docx
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Reasoning

✓

Q91 Reasoning
P, Q, R, S, T, U and V are sitting around a circular table facing the
centre. V is sitting fourth to the left of U. T is sitting second to the
left of V. S is sitting third to the right of P. R is sitting to the
immediate left of S. Who is sitting to the immediate right of Q?2331

A.  U

B.  S

C.  T

D.  V

✓

Q92 Reasoning
A’s father is the brother and only sibling of B. B is the son of C. K is
the wife of the brother of A’s father. D is the son of B, and E is the
sister of D. How is E related to A?2508

A.  Father's sister's daughter

B.  Daughter

C.  Father's brother's daughter

D.  Brother's daughter

✓

Q93 Reasoning
Pran starts from Point A and drives 38 km towards north. He then
takes a left turn, drives 42 km, turns left and drives 57 km. He then
takes a left turn and drives 64 km. He takes a final left turn, drives
19 km and stops at Point P. How far (shortest distance) and towards
which direction should he drive in order to reach Point A again? (All
turns are 90-degree turns only unless specified.)

A.  20 km to the west

B.  21 km to the west

C.  22 km to the west

D.  23 km to the east

✓

Q94 Reasoning
GLAD is related to INEH in a certain way based on the English
alphabetical order. In the same way, KPIL is related to MRMP. To
which of the following is OTQT related, following the same logic?

A.  QVUX

B.  PUVW

C.  RWTY

D.  QWVY

✓

Q95 Reasoning
Seven boxes Q, R, W, T, E, U, and Y are kept one over the other, but
not necessarily in the same order.
Only three boxes are kept above Y. Only one box is kept between U
and Y. Only three boxes are kept between U and T. T is kept at some
place above Y. W is kept immediately below T. R is kept at one of the
places above E. Q is not kept immediately above or below U.
How many boxes are kept above W?

A.  1

B.  2

C.  3

D.  4

✓

Q96 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

33 ÷ 3 + 19 × 19 − 2 = ?

A.  90

B.  95

C.  102

D.  100

✓

Q97 Reasoning
What should come in place of '?' in the given series based on the
English alphabetical order?
GDC JFF MHI PJL ?

A.  NJH

B.  TRE

C.  SLO

D.  JUY

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
are alike in a certain way and thus form a group. Which is the one
that does not belong to that group? (Note: The odd one out is not
based on the number of consonants/vowels or their position in the
letter cluster.)11721

A.  SXZ

B.  TXA

C.  XBE

D.  EIL
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✓

Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).
Statement: All Volcanoes are Tsunamis. All Tsunamis are
Earthquakes.
Conclusion I: All Earthquakes are Volcanoes
Conclusion II: Some Earthquakes are Volcanoes14532

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow

✓

Q100 Reasoning
Refer to the following series and answer the question (All numbers
are single digit numbers only. Counting to be done from left to
right.)
(Left) 1 8 7 2 6 7 9 8 6 4 7 9 3 1 8 7 5 8 3 4 5 6 4 2 3 5 2 5 (Right)
How many such even digits are there each of which is immediately
preceded by an even digit and also immediately followed by an odd
digit?

A.  More than three

B.  One

C.  Two

D.  Three
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